
Ubuntu brings Linux to the masses, but it can still 
be intimidating for newbies, neophytes, and geeks-in-
training. With Ubuntu Made Easy by your side, you’ll 
be ready to face any challenge, and you’ll discover 
just how fun Linux can be.

Packed with tips, tricks, and helpful pointers, Ubuntu 
Made Easy will get you up and running fast with the 
world’s most popular free operating system. Authors 
Rickford Grant and Phil Bull walk you through common 
tasks like installing and playing games, accessing your 
favorite social networks, troubleshooting hardware 
and software problems, interacting with your Windows 
installation, and more.

With the help of the book’s straightforward explanations 
and step-by-step projects, you’ll also learn how to:

• Set up printers, scanners, USB flash drives, and other 
hardware

• Install and play free games like Frets on Fire and 
Frozen Bubble, as well as commercial hits like Braid 
and World of Goo

• Edit and share digital photos and videos

• Watch DVDs, listen to music, and sync your mobile 
devices

• Create documents, spreadsheets, and presentations

• Work with the command line (or avoid it altogether!)

If you’re looking for a pain-free way to learn Linux, 
Ubuntu Made Easy is just what you need to get started.
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R I G H T - B R A I N  P E N G U I N S
Linux Does Art

Now that you know you can get down to 
business in Linux, it is time to don that beret 

of yours and address the artistic side of things. 
Yes, Linux does art, and as you will soon find 

out, a good number of programs on your system allow 
you to create and manipulate graphic files. These days, 
however, there is perhaps nothing so important to most 
users’ graphical repertoires as their digital cameras, so 
that is where we’ll begin. 

Where the Apps Are

The majority of apps in this chapter can be run from the Dash by clicking 
the Applications lens and then clicking the Graphics filter button. Exceptions 
are noted in the relevant sections. As with all applications, you can also run 
an app by typing its name in the Dash’s search box and then pressing ENTER.
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230 Chapter 13

Although scanner support for Linux can prove a bit spotty, support for dig-
ital cameras is practically a worry-free affair. In fact, Ubuntu pretty much 
treats your camera as if it were an external hard drive or flash drive plugged 
into your computer’s USB port (which is pretty much what it is). And even if 
your camera doesn’t seem to communicate with your computer when con-
nected directly, you can still transfer your images to your hard disk by remov-
ing the memory card from your camera, inserting it into a USB flash memory 
card reader, and plugging that reader into one of your computer’s USB ports. 

13A-1: Importing Images from Camera to Computer Somewhat Automatically 
via Shotwell
When you connect your camera to your computer via a USB cable, put your 
camera in play mode, and power it on, Ubuntu will usually automatically rec-
ognize it and open a window that asks how you want to import the photos on 
the camera. To import the photos via the photo manager application Shotwell, 
select the Shotwell option in the drop-down menu button, as shown in Fig-
ure 13-1, and then click OK. 

Figure 13-1: Ubuntu recognizes your camera and asks you how to proceed.

After that, here’s what you need to do:

1. In the window that appears, you will see thumbnails of all the photos on 
your camera. You can import all of the photos that appear by clicking the 
Import All button in the bottom right corner of the window. However, if 
you prefer to copy only some of the images, you can do so by holding 
down the CTRL key and then clicking the images you want to import, as 
shown in Figure 13-2. Once you’ve made your selections, click the Import 
Selected button.

Project 13A: Importing Images from Digital Cameras
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Right -Brain Penguins 231

Figure 13-2: Selecting which photos to import from your digital camera via Shotwell 
photo manager

2. Shotwell will save your photos to a dated subfolder in your Pictures folder. 
Once it is done importing the images from your camera, it will tell you so 
in an Import Complete window, where it will also ask you what you want 
to do with the photos still in your camera. If you want to keep them there 
for the time being, click the Keep button. If you would prefer to clear 
up space on your memory card by deleting the images, click the Delete 
button. 

The time it will take to import and delete photos from your camera or 
storage card will vary depending on the number of images on the card. Once 
the process is complete, however, you will be able to view them all within the 
main Shotwell window, as well as work with them further, a topic I’ll discuss 
later in this chapter.

13A-2: Transferring Images from Camera to Computer via the File Manager 
You can also use the file manager to import photos from your camera, if you 
prefer. If you happen to have digital movies on your camera’s memory card 
in addition to digital images, then you’ll have to go this route (for the movies 
at least) since Shotwell imports only images. The process for doing this starts 
pretty much the same as that in Project 13A-1, albeit with a slight twist. Here’s 
how you do it:

1. Plug your camera into one of your computer’s USB ports and put your 
camera into play mode. Within seconds, a window like that in Figure 13-1 
will appear. In that window, select Open Folder in the drop-down menu 
button (instead of Shotwell) and then click OK. 
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232 Chapter 13

2. A file manager window will appear, revealing the contents of your cam-
era’s storage card. An icon for your camera (looking like a USB drive) will 
also appear under Devices in the side pane of that window and any other 
open file manager window (Figure 13-3). And a message will appear at 
the top of the window telling you that the device you have connected 
contains digital images, along with a button that you can click to import 
the images with Shotwell. Since we covered that method already, you can 
ignore it for now.

Figure 13-3: You can also drag and drop photos from your digital camera as if it 
were a USB drive.

3. Double-click your way through the folders on your camera until you find 
the photos you want to import.

4. Drag and drop, or copy and paste, the images from your camera to any 
logical spot in your Home folder. 

5. When you’re done transferring photos, you can click the eject icon next 
to the entry for your camera in the left pane of the file manager window, 
or you can just turn off your camera. The file manager window that opened 
automatically will close, and your camera’s entry will disappear from the 
side pane of any other open file manager windows.

Shotwell not only imports images from your camera to your computer but 
also acts as a handy photo-organizing, browsing, viewing, and publishing 
tool, allowing you to easily send images via email without fiddling around 
with attachments. It also lets you just as easily publish photos to popular 
online sites such as Facebook, Flickr, and PicassaWeb. In addition, Shotwell 
serves as a simple photo-editing tool, allowing you to enhance; rotate; crop; 
remove red-eye from; and adjust the exposure, temperature, and saturation 

Project 13B: Working with Digital Images in Shotwell
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of a photo (Figure 13-4). Just double-click the photo you want to edit and then 
click the appropriate buttons that appear at the bottom of the window. You can 
pretty much learn by fiddling around; all the tools are pretty straightforward.

Figure 13-4: Shotwell provides you with basic but useful photo-editing tools.

13B-1: Publishing Images to Online Albums and Galleries
As I mentioned, Shotwell allows you to easily publish images to numerous 
online sites, much in the way that Windows Live Photo Gallery does. The 
method I show here for Facebook is essentially the same one you use for the 
others, and they’re all pretty simple. Here’s what you need to do:

1. In the Shotwell window, select the photos you want to post online by hold-
ing down the CTRL key and clicking each of the photos you want to publish.

2. Once you’ve made your selection, click the Publish button at the bottom 
of the window. A window like that in Figure 13-5 will appear. 

3. The default online site selected in this window is Facebook. If you would 
like to upload photos to Flickr or PicasaWeb, select that site in the drop-
down menu button at the top right of the window. Once you’ve done 
that, click the Login button. 

4. The login page for the site you’ve selected will then appear in the window 
(Figure 13-6). Fill in your login information and then click the Log In 
button (or equivalent for the other online sites).

5. In the case of Facebook, you will then be asked to name the machine you 
are logging in from. Once you have done that, you will need to allow 
Shotwell to access your Facebook information, something you’ll need to 
do whenever you log in from a new machine. 
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234 Chapter 13

Figure 13-5: Publishing images to online sites such as 
Facebook via Shotwell

Figure 13-6: Logging into Facebook via Shotwell

6. Once you have done all that, you will be asked to choose an album in 
which to publish the photos you’ve selected or to create a new album 
(Figure 13-7). Make your choices and then click Publish. 

7. Once Shotwell has completed publishing your photos, it will tell you so, 
and you can then click the Close button. You can then go to your online 
gallery via your web browser to see the results.
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Figure 13-7: Deciding which Facebook album will hold your photos via Shotwell

13B-2: Sending Images by Email via Shotwell
Emailing images via Shotwell is just as easy as publishing images to Facebook—
perhaps even easier. It’s certainly much easier than having to manually prep 
the photos as attachments. Assuming you have your Thunderbird set up for 
sending email as you learned to do in Chapter 5, here is all you have to do:

1. In the Shotwell window, select the photos you want to email by holding 
down the CTRL key and clicking each photo.

2. Right-click any of the photos you have selected and then select Send To 
in the pop-up menu. A window like the one in Figure 13-8 will appear. 

Figure 13-8: Emailing photos made easy with Shotwell
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3. Here you can change the size of the photo(s) you are about to send by 
adjusting the scaling constraints and maximum pixel dimensions. When 
you’re finished, click OK. 

4. In the next screen that appears, enter the email address of the person 
you’d like to send the image to, then click OK. An email message will 
then appear, and the photos you selected will be attached. You can write 
whatever message you like in that window and then send the email just as 
you would any other. Simple and sweet!

13B-3: Organizing Your Photo Collections with Tags
As your photo collection grows and grows, it can get tough to sort things out 
and find exactly what you need. Fortunately, Shotwell can make this a bit eas-
ier through the use of tags. Tags are categories that you create yourself and 
then apply to whatever images you want in order to organize your collection 
thematically. You might, for example, create tags for each of your family mem-
bers, or you might just create a broader tag for Family. You could create tags for 
cities and countries you’ve visited, providing categories and subcategories for 
your travel pics. The choices and combinations are endless, and you can decide 
what they are all are. Once you’ve applied these tags to your photos, narrow-
ing down your photo searches will be much easier.

The first step is to create a few tags. This is easily done by right-clicking 
an image and selecting Add Tags in the pop-up menu. A small window will 
appear in which you can just type a single tag or, to kill two birds with one 
stone, whatever other tags you want to assign to the photo (Figure 13-9). Just 
be sure to separate each tag with a comma. Once you’re done, click OK, after 
which the tags will appear both under the thumbnail and in the left pane of 
the window. 

Figure 13-9: Creating tags in Shotwell 

Once you have tags in the left pane of the Shotwell window, adding those 
tags to other photos is a cinch. Just drag a thumbnail to one of the tags and 
release your mouse button, and the image will be tagged. If you want to add a 
second tag, just drag the thumbnail to that tag as well. Once you are done tag-
ging your images, they will be far easier to sort, as you can see in Figure 13-10. 
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Figure 13-10: Using tags in Shotwell to make dealing with hefty photo collections much easier

Searching for images by tag is perhaps even easier than adding the tags 
to the images in the first place. Let’s say you wanted to find all of your images 
that you tagged as Europe. You would just go to the left pane and click Europe. 
All of the images that were tagged in that category would then appear in the 
right pane. Sweet.

A Few Other Graphics Apps to Consider

In addition to the graphics applications that come bundled with Ubuntu, still 
more are available. You can grab all of them via the Ubuntu Software Center. 
Although you can experiment with what’s available, I will point out a few 
worth noting. If nothing else, these applications will give you an idea of the 
breadth of stuff out there waiting for you.

RawTherapee
RawTherapee is not some solution for what ails your troubled soul but rather 
a handy application that allows you to manipulate RAW image files. RAW 
image files are images that have not been processed by the on-board conver-
sion software in your camera that converts the data it receives from the sen-
sor into a format that your computer is able to deal with (usually JPEG files). 
For most people, JPEG images work just fine, but many photographers who 
want to have the best quality results after making adjustments to their images 
on their computers save their files in RAW image format, or RAW mode. While 
not all cameras have the option to save files in RAW mode, many advanced 
amateur and professional camera models do. 

Once you load RAW image files onto your computer, the thumbnails for 
those files will appear as black rectangles. That’s because they are essentially 
blobs of raw data that neither you nor your computer on its own can make 
heads or tails of. In a sense, they are a digital equivalent of photo negatives. 
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This is where RawTherapee comes in (see Figure 13-11). Once you open 
your RAW files with RawTherapee, you will be able to see what they actually 
look like and then go on to adjust them to your heart’s content, usually with 
much better results than you would get if working on JPEG files. Once you 
have made your adjustments to the RAW files, you can save them into other, 
more universally compatible file formats, such as JPEG, while retaining the 
original RAW file for future use.

Figure 13-11: Working with RAW images in RawTherapee

Getting Arty with the GIMP
The Windows and Mac worlds may have Photoshop, but the Linux world has 
the GIMP (see Figure 13-12). Although arguably not as fully featured as 
Photoshop, the GIMP is a powerful contender, which may explain why it has 
been ported to both Mac and Windows. The GIMP allows you to create bit-
map graphics and, importantly, retouch or completely doctor image files. 
With the GIMP you can get rid of red-eye in your digital photos, airbrush out 
unwanted shadows (or even facial blemishes), give your image a canvas texture, 
change a photo into an oil painting, and even add a bell pepper here and 
there—with drop shadows no less. 

Because not everyone needs or uses the features of the GIMP, the powers 
that be decided to no longer bundle it on the Ubuntu Desktop CD, thus free-
ing up space for more frequently run applications. Pity though that might 
be, you can still install the GIMP via the Ubuntu Software Center. 
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Figure 13-12: Manipulating a digital image in the GIMP

Using the GIMP to Resize Images and Convert File Formats

 The GIMP’s main strength is in retouching photos. It is also a handy tool for 
resizing images. You can do this by simply right-clicking an image opened in 
the GIMP and then selecting ImageScale Image in the pop-up menu. This 
will open the Scale Image window, where you can set the new size of the image.

The GIMP is also an excellent tool for converting images from one file 
format to another. You can, for example, open a bitmap (.bmp) file and save 
it as a PNG (.png) file, save a JPEG (.jpg) file as a GIF (.gif ) file, and so on. 
Although this can also be done with other graphics applications, including 
Shotwell, the GIMP supports an extremely wide variety of file formats, and it 
even lets you save an image file as a compressed tarball, which makes it a true 
file conversion king. 

To perform a file conversion, just right-click an image opened within the 
GIMP and then select FileSave As in the pop-up menu. You can make the 
same selection from the File menu if you prefer. Either way, the Save Image 
window will then appear. In that window, you can specify the new file format 
by replacing the original file extension in the Name box at the top of that 
window with the extension for the format you want to convert the image to. 
If you’re not sure what formats are available to you, click the small arrow to 
the left of the words Select File Type (By Extension) at the bottom left of the win-
dow and then choose from the options in the pane that appears below. To 
save a work in progress, use the GIMP-native XCF format so that you can con-
tinue working on the image later.

Learning More

It’s lots of fun to learn to use the GIMP by just playing around with it for a 
while. To get you started, most of the fun stuff is located in the Filters menu 
of any image window. Of course, you should make a backup copy of any file 
you are planning to experiment with before you alter it. 
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If you prefer learning via manuals and tutorials to just goofing around, 
you can download and install the GIMP User Manual via the Ubuntu Soft-
ware Center by searching for gimp-help-en and then installing Documentation 
for the GIMP (English). Once it is installed, you can access the manual from 
within the GIMP from the Help menu. You can also view the manual online 
at http://docs.gimp.org/en/, and you can find a series of tutorials at http://
www.gimp.org/tutorials/.

Phatch Photo Batch Processor
While the GIMP and Shotwell are 
quite capable of handling the vast 
majority of your photo-organizing 
and editing chores, they lack an 
easy-to-use batch file conversion 
method that allows you to apply vari-
ous conversions to a group of files 
at the same time. For example, let’s 
say you want to convert 100 of your 
photos so they look like black-and-
white snapshots with white borders, 
are 50 percent smaller than the 
originals, have a similar thematic 
filename, and are saved in .tiff 
rather than .jpg format. Apply-
ing all these changes one by one 
would be excruciating. Fortunately, 
Phatch comes to the rescue! (See 
Figure 13-13.)

Using Phatch is easy—and 
quite a bit of hocus-pocusy fun. 
However, its interface might not be obvious for a first-time user. With that in 
mind, here is a brief rundown on how to use Phatch:

1. Click the + button in the main Phatch window, and the Phatch actions 
window will appear.

2. In that window, select the action (conversion) you want to apply to your 
photos and click Add. Repeat this process for any other actions you want 
to apply. 

3. Once you have added all the actions you want, click each action in the 
main Action List and enter the appropriate parameters for each action 
(size, file format, size of border, output location, and so on). 

4. If the actions are not listed in the order you want them to occur, click the 
action you want to move and change its position using the up and down 
arrow buttons. 

Figure 13-13: Batch photo file conversions 
with Phatch
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5. Once everything is ready, save your Action List with a meaningful name 
by going to the Action List menu at the top of your screen and selecting 
Save. This way, you can use it again if need be. 

6. Next, click the Execute button (the one that looks like three gears).

7. In the window that appears, select your conversion parameters, making 
sure to select whether you are converting a whole folder full of files, 
selected files, or whatever it is you have in the clipboard. I would suggest 
unchecking the box next to the words Overwrite existing images so that you 
keep your original images intact (Figure 13-14). 

Figure 13-14: Setting your final conversion parameters in Phatch

8. Once you have made your choices, click the Browse Folder/Browse 
File(s) button and then select the folder of files or individual files you 
wish to convert. Once you have made your selection(s), click Open.

9. You will now be back at the window where you selected your parameters. 
In that window, click the Batch button. 

10. Another window will then open showing you which files will be acted 
upon. Click Continue in that window. 

Phatch will then perform the conversions listed on your Action List in 
the order listed. It will show you the progress of its work, and a small window 
will appear to tell you when it’s done. You can see the converted product by 
clicking Show Images. If you failed to choose a destination folder, the newly 
created conversions should appear in a Phatch folder on your desktop.
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MyPaint
If you prefer to do your electronic artwork with a graphics tablet rather than with 
a mouse, then MyPaint is for you. MyPaint (Figure 13-15) is designed to work 
with pressure-sensitive tablets by Wacom and other manufacturers. Despite 
its simple interface, it features a never-ending canvas (so you can keep on draw-
ing in all directions until you run out of steam), an extensive brush collection, 
and even a brush-creation and editing tool. If you need a bit of help getting 
started, check out the online tutorial (http://mypaint.intilinux.com/?page_id=3). 

Figure 13-15: MyPaint for Wacom tablet artists

Inkscape
The GIMP, like other so-called paint programs, creates bitmap images in vari-
ous file formats. In these images, the location and color of every single pixel is 
recorded. Thus, the image is essentially a collection of dots. The file you cre-
ate is a rather hefty map of these pixels, and this map tells your system where 
everything in your image is supposed to go when it is displayed or printed. 

Vector drawing programs, on the other hand, create vector images, which are 
actually collections of mathematical formulas representing the various shapes 
in your image. This may sound arcane, and you may be wondering why you 
should care. But such drawings have advantages in certain cases. One advan-
tage is that vector image files take up less space on your hard disk than bitmaps. 
Another, and perhaps the most important, advantage is that shapes in vector 
images retain their smooth edges when the images are enlarged. A smooth cir-
cle created as a bitmap, for example, would begin to show jagged edges (“the 
jaggies”) when enlarged to any extent, while the same circle in a vector image 
would remain smooth and round no matter how much you increased its size.
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If you’re interested in giving a drawing program a go, then try Linux’s main 
offering, Inkscape (see Figure 13-16). You can learn how to use Inkscape at the 
Inkscape home page at http://www.inkscape.org/. Be sure to click the Galleries 
link on that page to see examples of what you can create with the program, such 
as the image shown in Figure 13-16 from http://focaclipart.net23.net/transporte/.

Figure 13-16: Inkscape

gThumb Image Viewer
In earlier editions of Ubuntu, an application called gThumb (Figure 13-17), 
handy for photo-handling chores, came preinstalled. Some folks wish it still 
did. It has almost all the same features as Shotwell and a few of its own (such 
as creating original web album pages and some limited batch conversion 
capabilities). That said, it all boils down to what you like, and since both 
gThumb and Shotwell are free and easy to use, there’s no harm in trying 
them both to see which one you prefer. 
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Figure 13-17: gThumb

Blender
To wrap things up, we turn to Blender, which is perhaps one of the most 
impressive open source applications available today. Blender (Figure 13-18) 
is a professional-level 3D modeling, animation, and rendering program. It is 
rather complex, but that’s the source of its power and popularity. (It comes in 
versions for just about every operating system out there.) If you would like to 
find out a bit more about Blender before taking the time (and disk space) to 
install it, go to http://www.blender.org/. 

Figure 13-18: Blender
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